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Introduction to PtMS IS - the Interactive Scheduler 
 

The PTMS Interactive Scheduler is an automated schedule tool for PtMS for Windows that allows users to 
perform automated scheduling, trip editing, client lookups in a Windows based interface. 

An online video with sound that demonstrates the basic features of the PTMS Interactive Scheduler can 
be viewed by click on this link: www.tsa-fl.com/ISDemo.html

 

http://www.tsa-fl.com/ISDemo.html
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Setup and Configuration 

Setup and Configuration operations prepare PtMS IS for live operation. 

Scheduling Parameters and color codes for trip record conditions can be adjusted for schedule operation. 
Database setup tasks needed to support schedule operation can also be completed.  
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Parameters 

From the View Menu, select Parameters to display the parameter settings: 

 

Parameters allow users to customize the scheduling solutions provided by the Interactive Scheduler to 
insure they meet local needs. 

Travel Time Parameters 

• Boarding/Disharge Times 
• Speeds 
• Peak Hours 
• Early Pickup 

Distance Parameters 

These parameters impact the estimated time of travel between stops in any schedule. 
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• Distance Calculation 
• Zones 

These parameters impact the estimated travel distance between stops in any schedule. 

Any adjustments to these parameters is instantly reflected in all schedules in the Interactive Scheduler. 

Penalty Calculation - How to define a "Good" vehicle schedule selection 

The Penalty Calculation parameters are used to rank the best to worst vehicle selections by inserting the 
trip into each vehicle schedule, then evaluating how well the trip "fits" and how it impacts the other trips 
in the schedule. 

A new trip "fits" well into an existing schedule if the trip is on-time for pickup and drop-off times, and it 
adds a minimum of travel time and distance to the vehicle's existing schedule. 

A new trips "impact" on the existing schedule is measured by whether the existing trips on-time 
performance is compromised and whether the existing trips travel time is unreasonably extended. 

The Penalty Calculation parameters measure the "fit" and "impact" characteristics of the trip on each 
schedule then combine them into a single Penalty Score. The lower the score the better the trip fits into 
that vehicle's schedule.  

Here is a list of the Penalty Calculation parameters: 

• Add Miles 
• Pickup Before Shift 
• Drop After Shift 
• Pickup Late on Take 
• Drop Late on Take 
• Pickup Late on Return 
• Drop Late on Return 
• Over Capacity Ambulatory 
• Over Capacity Wheel Chair 
• Over Capacity Wheel Chair (if WC=0) 
• Long Trip (Trip Exceeds established limit of minutes per trip) 

Penalty scores are grouped into categories - Excellent, Good, Average, and Poor. These 4 categories are 
Color Coded for easy recognition (see Color Codes). 

For additional help on adjusting parameters refer to the on-line video at www.abs-
pa.com/demos/online/ptmsis/ptmsis_parameters.html.  

http://www.abs-pa.com/demos/online/ptmsis/ptmsis_parameters.html
http://www.abs-pa.com/demos/online/ptmsis/ptmsis_parameters.html
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Color Codes 

Color codes provide a mean for the scheduler to identify specific schedule characteristics or events 
rapidly and intuitively.  

To adjust color codes or view the existing color code settings, select Help on the menu bar then select 
Color Codes to display the following screen: 
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You can adjust the color code assigned to a schedule characteristic or event by double clicking on it to 
display the color chart. Click on a color to select and change it. 
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Database Setup 

Once the SQL Express database is installed on the file server or workstation, the SQL database must be 
setup for the Interactive Scheduler. This setup step just connects the PtMSIS Interactive Scheduler to 
the PtMS for Windows SQL database 

To setup the database for PtMS IS operations follow these steps: 

1. Go to the Tools/Database Setup screen in PtMS IS: 

 

2. Enter the username and password for the PtMS for Windows SQL Server Express. The username is 
"ptms" and the password is "abs". Enter both in lower case. 

3. In the Step 2 selection box enter the name of your SQL Server Express server. This should be the 
computer name or server followed by a "\" then "ABS": 

4. Next select the name of the database. Enter "PTMS" in the Step 3 selection box. 

5. Select OK to complete the Database Setup and close the setup window. 
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Selecting the Schedule Date for Editing Schedules 

Currently users must select a schedule day/date from PtMS and export or send the schedule to the PtMS 
IS Interactive Scheduler. This operation only takes 10-30 seconds to complete. When scheduling tasks 
are completed in PtMS IS, the PtMS schedule database must be updated with the schedule results. This 
operation only takes a few seconds to complete. 

Both of these tasks are accomplished using the PtMS IS Data Exchange. A soon to be released SQL 
version of PtMS will no longer require this step since the entire database will be in SQL in this version 
and transport of schedule results between the 2 datbases will no longer be necessary. 

Loading a Schedule Date 

A Schedule date must first be loaded into the Interactive Scheduler before the user can edit the 
schedule. Click on the down arrow in the Select Schedule Date box to display the calendar. Select the 
schedule date then click on the button "Load Schedule Date" to display the schedule data in the 
Interactive Scheduler.  

Updating a Schedule Date 

All changes to vehicle schedules are saved automatically on the Interactive Scheduler screen. If the user 
closes the Interactive Scheduler and re-opens it, or opens another schedule date and returns to a 
schedule in progress, the changes will be saved and displayed on the screen. 

However, schedule changes made in the Interactive Scheduler must be sent to the PtMS SQL data base 
so the PtMS data base schedule reflects all the changes made in the Interactive Scheduler. This update 
should be peformed periodically throughout the day if you are working with the scheduler regularly or 
when you have completed a schedule session with a specific schedule date.  
 
Updating PtMS SQL database with the Interactive Scheduler results does not require the user to close the 
Interactive Scheduler, simply select the button "Update Schedule" in the top right corner of the Trips to 
Be Schedule window and the update is complete. 

We recommend you reload the schedule date using the "Load Schedule" button after performing an 
update. This will insure that any new trip requests that have been added since the schedule date was 
last loaded are displayed on the screen. 
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Scheduling Basics 

Included in this section: 

• How to edit a vehicle's schedule times 
• How to remove a trip from an existing schedule for rescheduling 
• How to add a trip to a vehicle's schedule 

The last item involves the mechanics of selecting a vehicle option for an unscheduled trip and adding it 
to the vehicles schedule. 

For a more detailed explanation of how to evaluate vehicle rankings (excellent, good, average, poor) 
refer to the web tutorial Selecting the Best Vehicle and Adding an Unscheduled Trip to a Vehicle's 
Schedule  

Editing Schedule Times 

Click on a Vehicle in the Vehicle List window to display the schedule for the Vehicle. 

https://www.abs-pa.com/Documentation/Online/PtMS72/ptmsis_help.htm#Select
https://www.abs-pa.com/Documentation/Online/PtMS72/ptmsis_help.htm#Select


Scheduling Basics       PtMS IS Interactive Scheduler  
Revised 10/25/07

 
 
 

- 13 - 
 
 

 

Click in any Scheduled Times field value (STime column) to edit the time. The OSTime column is the 
Original Scheduled (aka Default Time or Appointment Time) and is available as a reference. Once the 
time is edited click outside the field to save the time change. 

 

Removing a Trip from a Schedule 

To remove a trip from a vehicle's schedule: 
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Highlight the trip by right clicking on the trip in the "Trips for Vehicle" window. 

 

Left click on the "Remove Trip from Vehicle" option and the trip will be removed from the schedule and 
displayed in the "Trips to be Scheduled" window where it can now be rescheduled. 

 

Adding a Trip to a Schedule 

Step 1. Click on an unscheduled trip in the "Trips to Be Scheduled" Window. 
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Step 2. Review how PtMS IS has scheduled the trip and ranked the best to worst vehicle 
options. 

Color Codes provide schedulers with a means for instantly identifying the best vehicle options. 
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Step 3. Inspect the trip inserted in a vehicle's schedule by clicking on the vehicle in the 
Vehicle List and review the "trial" addition of the trip in each vehicle's schedule. 
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Step 4. Adjust Pickup and Drop-Times if needed and return to Step 2 

Pickup Times can be adjusted by using the Editing Schedule Times feature. 

 
Step 5. Select your vehicle choice and add the trip to the vehicle's schedule 
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Inserted Trips will appear in color throughout the scheduling session. 
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Last Vehicle 

 

Moving Trips from Vehicle To Vehicle 

One or more trips can be moved directly from one vehicle to a second vehicle. You can only move 
contigous trips in a schedule, that is, trips that follow one after another. If there are multiple sets of 
contiguous trips to move, the moves will have to performed several times moving each contiguous set of 
trips with each move. 

To Move a set of contiguous trips from one vehicle to another vehicle: 

1. Display the trips to move in the Trips for Vehicle window. 
2. Left click and drag your mouse down to highlight the trips to move.  
3. Right click on the vehicle in the Vehicle List and select "Move Trips to This Vehicle" to complete the 
move. 
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The moved trips will be highlighted and displayed on the new vehicle in the Trips for Vehicle window. 

 

Cancelling Trips 

Trips may be cancelled from the Trips for Vehicle window.  

To Cancel a Trip: 

1. Right click on the trip 
2. Select "Cancel Trip" from the right click menu. 
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The trip will be color coded to identify it as cancelled. If there is a return trip for this client a dialogue 
box will display and provide an opportunity to cancel the return trip. 
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Cancelled trips are removed from the scheduling process and are not included schedule calculations of 
distance and time for a vehicle.  

To UnCancel a Trip. 

1. Right click on the trip 
2. Select "Uncancel Trip" from the right click menu.  

Search-Edit Screen - Browsing All Trip Records 

The Search-Edit screen is accessed from the View menu.  
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This screen provides a means for browsing the entire schedule day. Records can be instantly sorted 
using the 3 sort buttons at the top, or sorted by click on the field headers. Pickup Time, drop-off time, 
and scheduled vehicle can be edited directly on this screen. 

 

Searching for a Trip Record 

A Search screen is available for rapidly locating a client trip records. This screen can also be used for 
rapidly locating all trips arriving at a specific location, etc, by resorting all trip records by clicking on one 
of the field headers. 

From the Interactive Scheduler menu bar select View, then Search: 
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Enter part of the name in the Search field box, then click on Search to display the trip records that 
match.  

 

Click on any trip record and this will display the trip record in the "Trips for Vehicle" window. 
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Database Operations 

Database operations allow users to lookup data records for tables that support the scheduling functions. 
Look tables include: 

1. Client Records 
2. Destination Records 
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Client Records 

The Interactive Scheduler can display selected client records or all PtMS client using a Client Records 
Browse window.  

Included in this section: 

• How to display a client record for a selected trip 
• How to browse and sort all client records 
• How to search client records for matches on selected fields 

Displaying Client Record for a Selected Trip 

The client record information for a selected trip record in the Trips to Be Scheduled window or the 
Trips for Vehicle window can be displayed by right clicking on the trip record and selecting Client 
Detail. 

 

The record will be displayed and can be viewed by scrolling right to display all the record information. 
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Browsing All Client Records 

 
From the Interactive Scheduler menu bar select View, Clients.  

 

This will display the Client Records browse window. Note, some fields are off the screen to the right and 
require the user to scroll right to see the display. 

 

To search for specific record in the Client Browse screen: 

• Click on the fields list drop down and select a field to search 
• Select the search criteria - either "Starts with" or "Contains" 
• Enter all or part of the field value in the search box then click the Search button* 

*Note: If you leave the search box blank and click on Search, all Client records will be displayed sorted 
by the search field. 
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Destinations 

From the Interactive Scheduler menu bar select View, Destinations.  

 

This will display the Destination Records browse window.  
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Mapping 

Mapping operations allow users to place selected trips or entire vehicle routes on the map. 
Once a vehicle route, or part of a vehicle route(s) are displayed on the map, the route can be 
manipulated by the users, pickup and dropoff order can be adjusted, trips added, etc. 

Mapping operations also allow users to geocode - assign map coordinates - to new unmapped 
addresses.  
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Mapping Trip Records and Vehicle Routes 

This section outlines how to use the Interactive Scheduler to map individual trip records, select trips 
within a vehicle schedule, entire vehicle schedules, and trips combined across vehicle schedules. Once 
mapped the street route and travel time and distance can be calculated and displayed on the map. 

Included in this section: 

• Overview of the Streets 2006 Map Software 
• How to access the map commands 
• Map commands summary 
• How to highlight trips on the map 
• How to add trips to the route list and produce the route  
• How to produce the route report 

 

 

Streets 2006 Map Software 

Opening the Map Window 

From the menu bar at the top select View, the Streets to open the Map window. 

 

Once the map window is open, the user has all the map menus and tools available. You must open the 
Maps menu and select your maps the first time the Map window is opened. Once installed, they do not 
have to be opened again even after closing and reopening the Interactive Scheduler. Just open the Map 
window before display trips records or entire routes on the map. 
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Select Maps to Open in Streets 

First Open the Streets Map from the PtMSIS View menu on the Tool Bar. 

Next, click on the Streets/Maps menu on the Streets Toolbar and you will open this window and click on 
'Add to List': 
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Next, browse to the C:\Streets\Map folder and click on this to select it. 
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Browse and find your maps in the list, click on the maps (CTRL+left click to select more than one) then 
click OK to open the maps. 
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Accessing the Map Commands 

In each of the three scheduling windows right click on a trip or line to display the commands menu. Map 
commands are listed in each menu. 
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Map Commands Summary 

Here is a list of the mapping commands available on the menus and a brief description of their function. 
Are more detailed description of the command is included in a separate help section below. 

Clear Map 

This selection clears the map display of all highlights and route stops. The Route list is completely 
cleared. Select this command when preparing to add stops or trips to a "clean map" that does not 
contain any previous routing information. 

Highlight Trip(s) or Stop(s) 

A trip represents the pickup and dropoff address. A stop can be either the pickup or the dropoff address 
of a specific trip. 
Highlighting a trip or stop simply attaches a label to that point(s) on the map. This option does not call 
the Map window to the top of the display. Popping up the map each time you selected a stop or trip 
record to highlight on the map would slow down mapping operations since the map would redraw and 
display with each highlight.  

Zoom Highlighted Trip(s) or Stops(s) 

Select the Zoom Highlighted Trips or Stops command to popup the Map window and resize the display to 
include all the highlighted points. 

Route Trip(s) or Stop(s) 

This command places the stop(s) in the Route list. They are appended to the end of the list. An icon is 
placed on the map at the stop location with a number representing the order in the Route list. 

Calculate Route 

This command calculates the street path route from the stops in the route list. The route is displayed on 
the map. 



Mapping Trip Records and Vehicle Routes       PtMS IS Interactive Scheduler  
Revised 10/25/07

 
 
 

- 39 - 
 
 

Highlighting Trips 

Highlighting a trip or stop attaches a label to that point(s) on the map. Here is an example of a Trip to 
Be Scheduled displayed on the map as highlights. After highlighting the trip, the user selects Zoom to 
Highlighted Trips to display the highlights on the map. 

 

 

Routing Trips 

 
Route Trip or Route All Stops places the selected stop(s) in the Route list. They are appended to the 
end of the list. In addtion an icon is placed on the map at each stop location with a number representing 
the order in the Route list. The Calculate Route command calculates the street path route from the 
stops in the route list. The route is displayed on the map. 
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Route Reports 

Once the Calculate Route command is executed, the user can request a detailed Travel Report for the 
route. The Travel Report lists the drive directions to each stop on the route. Travel time and mileage 
between stops is listed as well. The Travel Report can be edited or printed. 
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A sample Travel Report is displayed below: 
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Optimizing Schedules 

Optimizing Schedules involves taking existing schedules designed by the user and the Interactive 
Scheduler and determining if further improvedments are possible: 

1. Improve route efficiency by lowering travel miles and hours for a vehicle route(s) 
2. Improve on-time performance 
3. Increasie trips per hour 
4. Increase percentage of service miles and service hours per vehicle 
5. Lower average travel time per client 

Route Optimization and Trip Swapping are schedules tools designed to assist the user with achieving 
these results. The Vehicle List display and the Vehicle Productivity Report can assist the user with 
monitoring the schedule improvements. 

 

Route Optimization 

PtMS IS Route Optimization will assist users with reducing vehicle drive time and mileage in 
selected sections of vehicle schedules.  

Briefly stated, Route Optimization will take a set of pickups and dropoffs and determine the shortest 
pickup sequence (for a group of pickups going to a common location) or the shortest drop-off sequence 
(for a group of trips picked up at a common location at the same time and being taken home). 

When can you apply Route Optimization? 

• Consecutive pickups going to a common drop-off location. 
• Multiple pickups at a common pickup location being dropped off at home. 

Requirements for Multiple Pickups going to a Common Destinations 

• Pickup times must be flexible so that PtMS IS is allowed to change the pickup time sequence. 
• Pickups going to a common site must be consecutive. 
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• A common drop-off time for all clients will satisfy their scheduling requirements. 

Examples of Multiple Pickups Going to a Common Destination 

Example 1: 

Client A pickup 
Client B pickup 
Client C pickup 
Client D pickup 
Client E pickup 

Drop-off at Common Destination 1 for Clients A, B, C, D, E 

Example 2: 

Client A pickup 
Client B pickup 
Client C pickup 
Client D pickup 
Client E pickup 

Drop-off at Common Destination 1 for Clients A, B, E 
Drop-off at Common Destination 2 for Clients C, D 

Requirements for Multiple Drop-offs from a Common Pickup Location 

• Common pickup time for all clients at the common pickup location. 
• Flexible drop-off times. 

 
Examples of Multiple Drop-offs from a common Pickup location 

Example 1: 

Pickup Client A, B, C at Pickup Location 1 at the same Pickup Time 

Drop-off Client B 
Drop-off Client A 
Drop-off Client C 

Example 2: 

Pickup Client A, B, C at Pickup Location 1 at the same Pickup Time 
Pickup Client D, E at Pickup Location 2 at the same Pickup Time 
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Drop-off Client A 
Drop-off Client D 
Drop-off Client C 
Drop-off Client B 
Drop-off Client E 

Route Optimization Example 

Multiple Pickups to Common Destination Schedule 
 

 

 
Multiple Pickups to Common Destination Route Map 
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Apply Route Optimization 
 

 

Route Optimization Schedule Savings 
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Trip Swapping 

What is Trip Swapping? 

Trip Swapping means to move an existing scheduled trip to a new vehicle in order to find better vehicle 
options for a trip you are trying to schedule 

The "swap" creates a space for the new trip to be added to an existing Vehicle's schedule. The moved or 
swapped trip must also be scheduled on a different vehicle.  

The net effect of the swap should be: 

• On-Time Performance is maintained or improved for both trips 
• Total vehicles miles added to both vehicle schedules is reduced 

For a more detailed description of trip swapping procedures, refer to the help article on Trip Swapping.  

Trip Swapping Procedures 

How to Review Swap Options 

https://www.abs-pa.com/Documentation/Online/PtMS72/ptmsis_help.htm#Swap
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1. Select a reference trip to schedule in the "Trips to Be Scheduled Window" 
2. Click on the "Calculate Swaps" button  
3. Click on the "Vehicle Column" to review where the reference trip is being scheduled after the 

swap 
4. Click on the "Veh1, Veh2, or Veh2" columns to view where the swapped trip will be scheduled 
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How to Make the Swap 
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Reviewing Both Trips Scheduled 
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Reports 

The Report Menu can be accessed from the menu bar of the Interactive Scheduler: 

 

Increasing Windows Virtual Memory to Improve Reporting 

Go to your Windows Control Panel and Select the "System" option: 

 

Click on the Advanced Tab and the select Performance Settings: 
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On the Performance Options window select the Advanced Tab and then select "Change" Virtual Memory. 
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Increase your virtual memory, select Set, then select OK. 
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Vehicle Manifest in Stop Order 

Select Vehicle Manifest in Stop Order from the Report Menu. 

Choose the report options. 
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Click on Create Report to preview the report.  
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Select the print option from the tool bar to send the report to the printer. 
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Vehicle Performance 

Select Vehicle Performance from the Report Menu. 

Choose the report options. 
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Click on Create Report to preview the report.  
 

 

 

Select the print option from the tool bar to send the report to the printer. 
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Vehicle Manifest 

The Vehicle Manifest report is a highly customizable report. Users can select fields to include, display 
regions to include or exclude, and font types and size for each of 3 different report regions. There is even 
an option to select and display a company logo in the top left corner of the report. 

Users selections can be saved to a customization report file allowing the option of developing multiple 
display formats for this report. 
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Sample Report 
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Options 
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Customization 
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Dispatcher's Report 

The Dispatcher's Report is a highly customizable report. Users can select fields to include, and font types 
and size for each of 3 the report regions. There is even an option to select and display a company logo in 
the top left corner of the report. 

Users selections can be saved to a customization report file allowing the option of developing multiple 
display formats for this report. 

Sample Report 
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Options 
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Customization 
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ABS Support 

ABS Support Options 

• On-line Help 
• Remote Desktop Support  

On-Line Help 

From the Help Menu select On-line Help.  

The On-line Help link (PTMS IS Help Page) will connect you with the PTMSIS Help page where you can 
select help topic articles, or on-line help videos. 

The ABS Support page that links to ABS on-line support services is available at www.abs-
pa.com/Support/Support.htm  

Remote Desktop Support 

From the Help Menu select Remote Support.  

You will need to contact ABS in advance to arrange for a Remote Desktop Support session.  

Once the Remote Support selection is made a popup will appear on the screen. Highlight the ABS 
consultant's phone number and click connect. This will connect your workstation to an ABS support 
consultant where they will be able to view and run applications on your workstation. 

 

 

https://www.abs-pa.com/Documentation/Online/PtMS72/ptmsis_help.htm
https://www.abs-pa.com/Support/Support.htm
https://www.abs-pa.com/Support/Support.htm
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